
Optimum compact array antenna 
design using folded feed 

configuration 
By 

Ezaz Ahmad 
Sadia Alam 

S.M. Yusuf Ahmed 

Submitted to the 

Department of Electrical and Electronic Engineering 
Faculty of Sciences and Engineering 

East West University 

In partial fulfillment of the requirements for the degree of 
Bachelor of Science in Electrical and Electronic Engineering 

(B.5e. in EEE) 

[Summer, 2009] 

Approved By 

V 
Thesis Advisor Chairperson 

Dr. Ishfaqur Raza Dr. Anisul Haque 



Undergraduate Thesis 

ABSTRACT 

micro strip antenna to provide and ease of of 

antennas, so the array antem1a is widely used in real applications. Optimum array antenna 

to have minimum impedance mismatch the to return 

loss. To remove the the width the lines and transmission Jines 

to tuned across the network of feed lines. However, l arger tend to take up a lot of 

In 

turn 

the feed a antenna setup. 

a folding of the PTUlnrlr" is reviewed to minimize 

microstrip is used as the antenna choice for ,."'","'" 

introduce hence two other kinds 

We have also reviewed 

area taken up by an 

design. Sharp 

mitered and 

start resonating, 

been in the proposed 

optimized to width 

undesirable resonances. Quarter wave transformers have 

to perform the matching requirements. were 

networks to a 

Considering the reduction of impedance mismatch with different forms turns, we 

an Patch Antenna and we that antenna the Array. We have 

considered various types of by those we the 

best configuration for the line network. 
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1.1. 

Array antenna 

antennas are 

machines, sonar etc. 

. Motivation 

is not a new concept. Various works done on it. Currently, array 

in lots of applications communication, ul trasound 

the need to make these antennas affordable and It 

to gain and bandwidth, antenna and give some 

we use array antelmas rather than using one antenna. But if we place many antennas in array , it 

The now is to make every thing smaller. Increased demand of 

of IS more in 

application number of elements are to be accommodated In a compact 

that we wanted to decrease space taken up by an array antenna. 

main reason which us to do project was to able to a compact array 

antenna. It will help us design small but efficient portable devices in wireless communication. 

We have basically focused on microstrip patch antenna. 

microstrip antennas have eamed the most attention In 

lightweight, low volume, low planar 

last three 

communication [1]. Its 

microstrip that much popular. we studied the course of 

low fabrication cost make 

and Microwave, it made us 

to work on this microstrip patch antenna. 

of Electrical and Electronic East West University 10 
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1.2. Review 

Today's world is totally dependent on communication. Antenna is a vital part of the 

communication system in to and In recent time microstrip antenna 

is mostly antenna to light weight, thin, and the possibility 

integrating the feed network into antenna design [2]. microstrip array antenna design is a 

familiar area, information was to us. We about 

and array antenna design from many books, journals, article, handbooks, papers etc. 

There are several books describing antenna fundamentals among which and [4] are very 

for us. In fact the book helps us mostly to develop our basic on all about antenna. 

There are some handbooks [5] and despite rather old, these books cover many 

"""f.'v"""" of microstrip design. 

review articles from which we have added information in our paper are (1], [7], [8] 

and [9]. Among which first paper is written by Matzner, Sasson, M. Yacobbi , and M. 

Haridim are most recent published and more advanced things on 

microstrip design. Second one is written by Breed where basically talks about 

structure and of a Microstrip patch antenna. The author of the third is R.W. Dearnley, 

and was very us on behalf of transmission line modeling. M.e. Horton and RJ 

Wenzel in their article describe quarterwave designing technique which helps us mostly to �_u.,.,u 

an which is to eliminate our At1icle 

written by 1. Lagerqvist [2] us a smart and proper direction to prepare our undergrad final 

project report. 

There is an article which we didn't use in our paper directly but helps us to build our basic [10]. 

IS by V. R. S. Kumar, and [1 IS a helpful 

paper for us in an array antenna. At same time we found suggestion of using 

quarter wave transformer two antennas array in this paper. 

Department of Electrical and Electronic East West University I I 
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1.3. Thesis Review 

The first part of the second chapter introduces an antenna system. In second part it contains 

antenna types and their uses also. Third part basically talks about microstip patch antenna, line 

feed and familiar applications of microstrip patch antenna. And the last part of the second chapter 

represents antenna arrays and its advantages. 

Chapter three is the analysis of the antenna. Here we try to gIve a brief idea about antenna 

parameters like resonant frequency, return loss etc. We also represent two basic antenna 

modeling types which are transmission line model and cavity model and necessary mode require 

modeling the antenna in chapter three. 

Chapter four is the most important part which describes design of a microstrip antenna array, 

discussing aspects like chooses of antenna parameters and resonant frequency; find out the 

optimum feed position, elimination of the impedance mismatch. In the same chapter we talk 

about design of quarterwave and different configuration of quarterwave like folded, round and 

mitered turns quarterwave. We also tried to move our project to a new direction by changing the 

length of the quarterwave, varying number of antennas in the array and represent all these in this 

chapter. 

Simulation and results are exists at chapter five. In this chapter we basically show different 

configuration of antenna placement. We studied different simulation results for both small (lx2) 

and large (2x2 and 2x4) number of arrays. In addition we also studied cases where length of the 

quarterwave is modified (both increases and decreases). We also try to find out the best 

quarterwave configuration (round turns or mitered). 

Finally we conclude by offering some future work in chapter six. 

Department of Electrical and Electronic Engineering, East West University 12 
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1. Antenna System 
An antenna system all the 

the radiator. 

is parts of an antenna [1 1  ] .  

1:\nteull a 

the transmitter or receiver 

l ine, baluns, and 

..------4 TV 1 

TV2 

Figu re 1: Antenna system 

2.2. 

2.2.1 . ...::::==&�==-=--.:��=� 

ttpr't:'nt types of antennas are based on shapes, working 

demands etc. common and used antennas are Wire ... unvu ...... .". Aperture antennas, 

Microstri p  Array «U',vILU"'''' antennas etc [3]. 

antennas are familiar its use on automobiles, buildings, ships, 

spacecraft etc type of antennas has various shapes such as straight is also 

called loop, helix etc. Only circular antennas are not call loop 

ellipse and shapes are antenna family. Popularity 

antennas is increasing its sophisticated forms and 

higher This type of antenna is useful in 

of 

applications 

because can be 

condition 

[3] .  

flush-mounted on the 

are converted to a dielectric 

Department of Electrical and Electronic East West 

the aircraft or spacecraft and 

which the or 

1 3  



J 

vi 
(b) Circular loop 

2: Wire Antenn a  configuration 

(a) Pyramidal horn (b) Rectangular waveguide 

Figure 3: Aperture antenna configuration 

Today microstrip antennas have government and applications. This type of 

antennas consist a metallic patch on a substrate. patch different 

configuration circular. antennas are widely used in aircraft, 

cars, mobile telephones etc [3]. 

(a) Rectangular Microstrip, (b) Circular Microstrip 

Figure 4: Microstrip antennas 

lp,,�rt,mpl,t of Electrical and Electronic East West 14 



is such radiation one elE:m(�m in a direction 

while in all other directions minimize. In individual radiators are separated. 

use of Array antennas are 

Rl:'flector 

DIivell Fol(led 

DiIWIt> 

to radiation 

(a) Yagi-uda array (b) Microstrip patch array 

5: Array a n tennas 

Reflector antennas are '-'iI.H'-'U type of antennas which are used when transmit and receive signals 

to travel millions of antenna is  antenna. This 

antennas has 

A very common 

in meter scale .  large diameters is  helpful to achieve 

required to transmit receive 

Reflector 

Rndiahng Q1' re-q:,�iyilig 
e-lNn€'ut 1tt till? focus of the 
nuy� 

(a) Parabolic reflector 

after million of miles o f  travel.  

(b) Corner reflector 

Figure 6: Rellector antennas 

1"",,, ... ;-,,,, ,,,,, 1 of Electrical and Electronic Engineering, East West University 15 



antennas basicall y  prevent in undesirable as same 

application as ref1ector antennas but it works at higher frequencies. Lens antennas are classified 

to their material or to their geometrical 

(a) Convex-convex lens antenna (b) Convex-plane lens antenna 

Figure 7: Lens a ntenna configuration 

2.3. Microstrip Patch Antenna 

Microstrip patch antenna of a radiating patch on one side a dielectric substrate with a 

continuous metal layer bonded to the opposite of the substrate which a ground 

[4]. patch is of conducting material such as copper or gold and can take any 

possible A patch antenna is a narrowband, wide-beam antenna by photo etching 

the antenna element pattern in metal trace on dielectric substrate [7]. 

Dielechlt SubstJMe 

Figure 8: Microstrip Patch Anten na 

Microstrip antennas are 

simple 2-dimensional physical 

triangular, and elliptical or some 

antenna is a patch. 

to manufacture and because the 

IS generally square, rectangular, circular, 

common shape. most commonly employed microstrip 

rectangular p atch antenna is one-half 

wavelength long of rectangular microstrip transmission [1 2]. 

Department of Electrical and Electronic East West University 16 



patch is 

Microstrip 

A conducting 

Thesis 

is usually < L < 0.5)" where A. = wavelength. The 

thin such that t t" where t is patch thickness. Height the dielectric 

h < 0.05 A.. dielectric constant is typical ly  

is  d irectly connected to edge of the microstrip 

< < 1 2. 

as shown in 

figure, conducting is smal ler in width as compared to the patch and this of feed 

planar structure. 

the feed l ine to the 

that 

without 

feed can etched on same 

this cut the patch is to match 

need of any additional matching 

to 

impedance 

a 

Microstrip transmissiol 

Below 

appl ication 

---.. feed 

Figure 9: Microstrip Path Antenna 

typical appl ication of microstrip antenna. of  

transportation, communication to  biomedical i s  below in table 

Table 1: Application of Microstrip Antenna 

blind landing 

communications[ 1 4] 
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2.4 Antenna arrays 

1 

U ses of antenna arrays are very 

gain the antenna. Moreover 

many ways[4]. of all, it 

d iversity reception. If  we can 

it is most sensitive in a particular direction so use of cancel out 

particular set of directions. Array help to detem1ine the direction 

the overall 

the 

from a 

arrival of the 

signals .  Furthermore use of than a patch can the 

to Noise Ratio (SINR). 

Gain: using arrays increase overall of system. In our work we while 

0 

-5 / 
! 

co -1 / 
::s:. 

� -1 

-2 

-25 
0 5 10 15 20 25 30 

Frequency 

we used microstrip antenna rather than a 

Figure 10: (a) Single patch, (b) Return loss versus frequency curve for single pa tch antenna 

Frl!<juency 

11: (a) Patch array, (b) Return loss versus freq uency curve for patch array anten na 
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Comparing above results we can say that return loss minimize while we use array antenna and as 

we know minimization of loss means increase of gain. So it we can say uses of array increase the 

gain of the system. 

Diversity reception: Received signal's power varies significantly with small changes in distance. 

A diversity array uses a set of antennas and combines signals to obtain the maximum signal [4). 

Interference cancellation: Arrangement of arrays is such that radiation from one element in a 

particular direction maximize while radiation in all other directions minimize. So use of arrays 

cancels out interference from a particular set of directions. 

Determination of direction of the upcoming signal: The adaptive antenna can be steered to the 

last known best direction for reception of a particular detected signal. Detection of incoming 

signal helps in interference cancellation so that signal quality improves. 

Maximization of the Signal to Interference plus Noise Ratio (SINR): As we know use of 

array causes interference cancellation which improve signal to interference noise ratio. 

Department of Electrical and Electronic Engineering, East West University 19 
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3 ANTENNAANALYSIS 

3.1 

Resonant frequencies: 

Resonance is the ""iJlU,","" o f  a to oscillate at larger amplitude at some frequencies 

than at are referred as resonant UvUv,lv':> [1 8]. an 

Circuit when the between the input and output of the circuit is at a minimum then 

resonance occurs. This generally happens when the impedance npT'U!�'A 

IS zero. 

In the figure below the impedance is minimum at the frequency of 

output impedance is set to minimum at 

operated.  

-5 

811 

Frequency 

In frequency 

Figure 12: Resonant frequency 

input and output 

input and 

antenna can 

Resonance of a can equation, 

. . . . . . . . . .. . . . . . . . . . . . . .. . . .. .  (1) 

Where, 

Constant, and he = Resonant 

Department ofEJectricaJ and Electronic East West University 20 
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Radiated power 

radiated power or equivalent radiated power (ERP) i s  a standardized theoretical 

measurement of radio frequency (RF) having SI unit watts [19]. We radiated power 

by losses addi ng calculation 

output (TPO), transmission line attenuation (electrical resistance RF radiation), connector 

insertion and antenna directivity i s  I S  typically applied t o  antenna 

a example, i f  an antenna """·r",,.,,., has 9 dB and 6 dB loss, its is  3 dB. 

I f  ful l-wavelength spacing is used np,·,,/p.>n antenna elements in an array, ERP is  increased 

multiplicatively with 

Return loss 

The return (RL) is a 

Gain-Loss 

which amount of "''''XlP'' that i s  lost to 

and does not return as a reflection.  we know, waves are reflected leading to 

standing waves, when the transmitter and antenna impedance do not match. 

formation of 

RL is a 

to VSWR to indicate how well matching t"\01'U7.'»,.., 

The is defined as ° 

F or perfect matching between transmitter and and J, which means no 

power IS back, an RL=O, 

reflected. In practical application, a VS WR of 2 is  

11 power [20]. 

3.2 Antenna modeling 
modeling can done two ways. is 

IS 

to an of dB or 

l ine model and is cavity 

modeL In our experiment we used transmission l ine modeL Transmission l ine model TPrITP<;:t>n 

microstrip antenna by two slots, separated a low-impedance transmission l ine of length 

3.2.1 

a 't"<>Y,CrYI to calculate impedance. 

lumped transmission l ine model with 

fJ ... "· H  .... 'CL'V� are all normalized 

Department of Electrical and Electronic 

series i nductance, shunt conductance and 

unit length is shown below [8]. 
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Figu re 13: Lumped lossy t ransmission l ine model 

expressIOn the impedance is: 

We considered a l ow-loss transmission line, the fol lowing wil l  occur: 

«jOJC R «jOJL 

characteristic .1..1"' .... "' •. 1v'"' equation to: 

we had to vU1vUIUC"- the 

Equation below-

Where is the impedance 

looking in to and 

1.1 

of the This was usmg 

line as a quarterwave transformer), is the impedance 

impedance which terminated both of the 

must consider special characteristic of the transmission line model it influences 

the resonant the antenna. Though he the are along 

length width; the fields at the of the patch This shown below: 

-::-:-t----;.. Fringing 

14: 
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Fig u re 15: Electric field  l ines 

In fringing electric lines exist in IS 

non homogeneous line of two Typically dielectrics are 

Due to line looks electrically to its dimension. 

Typically  dielectric constant has in the range most applications 

dielectric constant of the substrate is much greater than unity (E:r » 1  ), the value 

wil l  t o  the 

dielectric constant is also a 

the actual constant of substrate. 

of frequency, as the frequency operation 

effective 

most 

a line 

substrate. 

concentrate in the substrate. microstrip 

effective constant approaches the 

behaves more 

of the dielectric 

Microstrip antenna l ooks cavity ful l  with \,,u,-,,,,,,",u By cavity model normalized 

fields within the patch the ground can be more 

This exhibits input power so 

quantity can 

understand 

compare 

formation 

with measurements. To the cavity one should 

fields within cavity and the 

When microstrip is energized, 

surface which is in the 

distribution is established on 

below-

w 

through 

upper and 

Figure 16: distribution a n d  c urrent density creation on Micl'Ostrip a ntenna 
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in a cavity model is controlled by two and 

mechanism. The mechanism is between the opposite charges on the 

bottom side of the patch and the plane which tends to maintain the charge concentration 

on the bottom of is between like on the bottom 

mIcro 

of to push some from the bottom of the path around its 

top s urface. 

the 

movement of this charge creates current. 

IS small, the 

most practical 

most 

of charge concentration and current flow remain underneath the patch. A small amount of 

current flows around the of the patch to its top surface. Thi s  current flow as 

width If current flow to the top is zero, which is i deal and not create 

any tangential magnetic field components to the patch. allows four side 

walls to modeled as magnetic conducting not d isturb the magnetic 

the field distributions below the patch. is a finite 

hei ght-to-width ratio, although small, 

exactly zero. they will small, a good 

treat 

electric 

conducting. 

d istributions (modes) beneath 

3.2.3 

Transversal Magnetic ylode 

would not be 

model is to 

good normalized 

In the magnetic or modes means that only three field components are 

considered. The three field in z d irection i s  perpendicular to the ground 

and x-y d irection that are paral lel to the plane. In general modes are designated 

as TMxyz. Z IS the variation i s  the 

TMxy remains with x and y field variation in x and y 

in the y d irection (impedance width direction) i s  y i s  O .  Lastly the 

has one variation the x x IS 

in a fundamental case. the notation is TMIO 
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4 FOLDED ANTENNA ARRAY FEED 

4.1 Microstrip Patch Antenna Arrays for 12.8 GHz 
Antenna designed by Gonaca Gakir and Levent Sevagi has been used here as a reference (2 1]. 

Antenna Parameters: Length of the Antenna is L = 4.0 1 mm, Width of the Antenna is W= 

3 .55mm, Width of the feed = 0.47 mm, position of the width from the top= 0.89mm. In the 

Layout of ADS we used the Momentum Menu to design the Patch. 

0.47mm 

Figure 17: Microstrip patch antenna 

4.2 Elimination of the Impedance Mismatch 

The Resonant frequency was observed to 24 GHz. Due to mismatch in the impedance between 

the Feed l ine and the patch, the Feed width was redesigned to get the better resonant frequency 

and remove the impedance mismatch. So we calculated the width of the feed to be 0.5 mm using 

LineCalc. The design of the patch is of 50 ohm so we chose the width 0. 5 mm for feed line and 

got the same impedance of 50 ohm. Then we simulated the design and found that the resonant 

frequency was about 1 2.8 GHz and the return loss of 1 5  dB. 

Figure 18: Microstrip patch antenna with new feed line width 
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4.3 The Optimum 
return was not as PV'�Ai"t",rl 

position of the feed l ine along the 

position 
only - 1 5  dB.  To 

of patch. From the 

Table 2: Feed position optimization 

0 4. 
05.  
06. -3 6.97 

0.9 1 ---
os. 0.92 
09. 1 .0 - 1 5 .2 1  

return loss we 

we see results. [22J 

1 2.S1 
1 2 .S1  
1 2. S 1  
1 2 . S4 L-______ � _ _ __ ________ � ..... �.�.�________ ______ ...... � _________________ • 

From the we see that we set the Feed l ine at 0 .S9 mm the then we 

minimum return loss. The minimum return loss is -53 .5 1 dB. 

4.0 1 mm 

the 

t 0.5mm 

19: Microstrip patch antenna having optim um feed position 

4.4 Different Configuration of 

1 

Array antenna we have width of al l the symmetric, i .e. same. wil l  

however impedance mismatch at the junction of feed l ines. The impedance of the 

Department of Electrical and Electronic East West University 26 
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feed will be double of the parallel combination of two antenna Due to the 

mismatch there will a distortion in the resonance S -p arameter simulation will 

us those 0 .50mm 

I) 

Figure 20:1X2 Microstrip a rray a n tenna with sym metric feed line 

1.2 Design: 2 x 2 

In 

then 

picture below we connected antennas in array, as we connect more antennas 

paral lel needs to be calculated again. But the line width is 

kept symmetric then we will have more impedance mismatch in line width, so 

more distortion the 

Width 0.5 mm 

FigUl'e 21: 2x 2 Microstrip array antennas with sym metric line feed 

4.4.2 

We can proceed our design by the width line an 

have used the option o f the ADS to calculate the width the 

4.4.2.1 Arrcq Design: 1 x 2 

given parameters. 

Using LineCalc we calculated width the parallel feed is 1 .62mm for 1 x 2 

array antenna to match the impedance 500hm 

Department of Electrical and Electronic East West University 27 
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Impedance Matched using LineCal c :  

When w e  split the the width needs to be in a Impedance has to be 

In our design mismatch is .. or",,,.,,,,,, by using LineCalc as we 

cause 

taken the c alculated width but width 

probl em. 

of is  itself 3 

can itself behave l ike an 

so if the 

we will 

3 .86mm 
<II .. 

1 .62 mm 

w as calculated 1 . 62 mm which can 

l ine width is 1 mm then feed 

resonance frequency which is not 

Figure 22 :  1x 2 Microstrip patch a n tenn a  using spl it t ing transm ission l i ne feed 

4.4.2.2 Arrt9' 2 x 2  

N ow we have designed 2 x 2 

match the Impedance by varying 

the width the feed 

antenna 

width of feed 

same splitting feed line method to 

As we split the feed line to match the 

feed l ine width C'"",.,,,",ti to 4.029 mm 

which is greater 

more distorted, the 

the width of Antenna itsel f. So we can assume that the will 

as antenna 

width of the Antenna is 3 .86mm so the 

can behave l ike an 

we wil l  have more resonant frequencies. 

line width is 1 l ine 

another undesired resonance 

4.029 mm 

1 

23: 2x 2 Microstrip array antennas using spi l l i ng  transm ission l ine feed 
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4. 5 Quarter wave Design 
of i s  renowned to remove between the load and th� 

transmission l ine. got various written on it among which paper written by 

M.C.  [9Jhelped us mostly. 

input UJv, .. .... u'v'"' of i s  5 0  ohm. And impedance we set to 1 00 

ohm. The width we calculated LineCalc is 0.06 mm 

Quarter wave impedance x ) = 70.7 1 ohm 

Feed -.-.-,-:.� Load 

Figure 24: Quarterwave 

LineCalc we can a Q uarterwave which the 70.7 1  ohm 

Using LineCalc we find the width i s  0.2 1 mm and the is 3 . 00 5  mm, but we added some 

mismatch to the best results so we assumed the length to mm. 

! 
0.2 1 mm .---------------------------------------------------. 

Figure 25: Qua rterwave we designed 

"" E ieclrical "" " 

2 .90mm 

D8 = 0 025 
inDepln = 0.030 

26: LineCa lc option of ADS to find the characteristic i m ped ance of the 
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In this design we 

transmission 

used Quarter wave transfonner, Quarter wave have eased our design, 

of Quarter wave was calculated 70.7 ohm so the width is and 

is 1 00 ohm so the width is more reduced so we H<ULUI',vV to solve 

problem excess resonance frequencies. From _ _  �. ,.., . .  1 x 2 array antenna we can hope for 

results. 

a rray a ntenna using q u arterwave 

4. 5.2 

have 2 x 2  as we proceed 2 x 2 anay designs we find that we 

lines anay which eases our task . For 2 x 2 Array don 't  need to redesign the 

antenna the return loss can reduced and the resonant frequency is not 

Quarter wave 

Fig u re 28: 2x2 patch a r ray a n tenna q u arterwave 

,,,,,,.rrw',,nt of E lectrical and E lectronic East West University 3 0  
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4.5.3 Array Design 2 x 4 using quarterwave 

We have designed 2 x 4 antennas order to get 

bit i n  i mpedance is a 

2 x 2  

Quarter wa 

gam, our d es ign can be l ittle 

So return can improve 

29: 2x4 patch array antenna using quarterwave 

Advantages of using Quarterwave over a Symmetric feed and split 
matched feed :  

The main reason to use quarterwave i s  it prevents to change the resonant frequency of the circuit. 

At same time we can use the same transmission width 

arrays. J...}v':HU\v the as transmission l ine width i s  

the number of 

so i t  starts behaving 

like an Antenna which results another resonant B ut Quarter wave eliminates 

problems. Moreover low Return loss and elimination of excess resonance frequency can be 

achieved using quarterwave. 

Constrains of Using Quarter wave in  General way: 

we were Quarter wave of 2 .90 mm in our array design the l ength for the i ncreasing 

was simultaneously.  So for a l imited 

Moreover low and of excess resonance 

quarterwave. 

of Electrical and Electronic East West University 

the is not applicable. 

can be achieved using 
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4.6 Our Proposal 

So we proposed Folded Quarter wave which is  helpful to reduce the l ength 

Total l ength the 
folded quarterwave -------li>! 
is 2 .90mm 

30: Folded q u a rterwave 

above we can see that the length of the Quarter wave was reduced significantly. 

So  this 

the 

will  help to the length. The length the Quarter wave was measured by 

value of the internal and external S o  we the mid path to measure the 

4.6. 1 .  1 ArrtV' using Folded Quarter wave: 1 x 2 

We have now appl ied fol ded Quarterwave in our Array design.  width of the 

wave is not identical al ong the l ine because in the turns width of Quarter wave i s  higher 

the straight 

So wil l  be an impedance mismatch at the turns. As a result we wil l  

distortion. 
Folded Quarter wave 

F ig u re 3 1 :  ! x2 patch a rray a n tenna us ing  folded q ua rterwave 

can excess resonance frequency the return loss wil l  be distorted as the width is not 

constant along 
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1.2 2 x 2 

Now we have applied the folded Quarter wave in 2 x 2 alTay design. I n  this design we have used 

waves. So the i s  more turns so wil l  be 

more distorted. The return will reduce and will be excess resonance frequency. 

the 

antenna we 

Folded Quarter wave 

32: 2x2 patch array antenna using folded q u arterwave 

Quarter wave there will  mutual 

excess resonance. 

so it can behave l ike 
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4.6.2 Curved Turns Folded Quarterwave 

In the general folded Turns we had a width variation along the l ines and the turns had higher 

width, so to remove the problem we proposed another solution, we would curve the turns of the 

Folded Quarter wave. Using ADS design tool we have curved the turns of the folded Quarter 

wave. 

Total length of the 
Curved turns folded 
quarterwave ----.� 
is 2.90mrn 

Curved Turns 
� 

Curved Turns 
Figure 33: C u rved tUrns fo lded qua rterwave 

The proposed idea can make the width uniform along the l ine and even on the turns. So then we 

can have low return loss. We can apply this design in the Array. 

4. 6.2.1 Curved Turns Folded Quarter wave: 1 x 2 

We have appl ied the Curved Turns folded Quarter wave in the Array design, it will help to reduce 

the return loss and the resonant will be accurate because the width is matched along the line this 

time. 

Figure 34: I x2 p a tc h  a rray a n tenna using curved turns fo lded qua rterwave 
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4. Folded Quarter wave: 2 x 2 

same design i s  applied i n  2 x 2 antenna to maximize the we go further into the 

will  resonance can the 

Return 

Folded 

35: 2 x2 patch a r ray a n tenna c u rved t u rn s  fol d ed q u a rterwave 

4.6.3 

can use another option is Mitered; here the turns will be mitered to match the 

width. A j oint is a j oint made by beveling each of two to j oined, usually at a 

to form a corner, usually a 90° 

Mitered 

Mitered Tums 
Figure 36: Miterea t u rn s  folded q ua rterwave 

Mitered tums will help us to remove the width variation at turns so we can a 

result analysis .  
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4.6.3. 1 Arrqy Design: 1 x 2 

We have applied the Mitered Turns folded Quarter wave in our array design. We can expect a 

better result because the width is aligned along the l ines so there impedance mismatch wil l  be 

removed. So we can have better Return loss parameters and the resonance frequency will remain 

same. 
Mitered Turns Folded Quarter wave 

Fig ure 37: 1 x2 patch array anten na using mitered tu rns folded q u arterwave 

4. 6.3.2 Mitered Turns Quarterwave: 2 x 2 

Now we have applied the Mitered turns Quarter wave in our Array of 2 x 2, this design will 

compact the size of the antenna and the mitered turns will make the width uniform along the 

lines. So we can expect better return l oss and we can expect the same resonance frequency. 

Mitered Turns Folded 
Quarter wave 

Mitered Turns Folded 

Figure 38: 2x2 patch array antenna using mitered tu rns folded q u arterwave 
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New 

we have 

4.7.2 

4.7 Changes · Folded Quarter transformer Length 

the quarter wave is 3 .02mm the 

the length then the mismatch i mpedance 

range of o f  the folded Quarter Wave. 

2 .90mm. As 

appear. We can then 

39: 2x2 array antenna the quarterwave wh ich has the length i ncreases by 5% 

We have decreased wave by 5 % .  So it is now 

is not "',H10>'« '-' 

the 

then the 

range of the length the AVA'" ''''"''' Wave 

Figure 40: 2x2 patch array antenna using the q uarterwave which has the length decreases 5%) 
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8 using folded wave: 2 x 4 

Using Curved Turns Quarter wave: 

As we in  the 2 x 4 Array design we can increase the gain the Antenn a  but if there is 

l ittle impedance mismatch then in an array the mismatch will  tum into So retum loss 

can an d resonance frequency can 

Figure 41 : 2x4 array antenna using folded q uarterwave 

Using Mitered Turns Quarter wave: 

we precede in the 2 x 4 Array design we can increase the gain of the Antenn a  but if is 

little impedance then in an mismatch will tum into So retum loss 

can increase and the resonance frequency can vary. 

Figure 42: 2x4 array antenna mitered turns folded qua rterwave 
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5 

we are simulating a Patch In the Layout window of  we 

the patch simulated momentum. we started with a regular patch antenna with a 

feed the parameters are as fol lowing. 

Length of antenna= 4.01mm 

Width antenna= 3 

Width of the 3 

position the top= 

0 

-5 

- 1 0 
0) 
ro - 1 5 � 

-20 

-25 
0 5 

1 

1 0  1 5  20 
Frequency 

43 : Ret u rn loss versus freq uency curve fo r 

simulation results, 

Resonant frequency= 24 and, Return -23dB 

25 

We can see that the resonant frequency is higher and return loss is also 

we changed feed of the width to O .50mm to match the JVU'HJ.U 

Department of Electrical and E lectronic Engineering, East West University 
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Resonant 
Frequency 
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S 1 1 

-5 

-1 0 - - -

_L_- -_-1-- i�::nance 

+----t----II · I 
j 

I 
-1 5-1--.----r--.---,--f---r---.---r--r-l--.----r�::::;::::=;::::;::::;::::;:=r_-... 

o 5 1 0  1 5  20 

Frequency 

Original 
Resonance 
frequency 

Figure 44: Return loss versus frequency curve after changing the feed width 

From simulation result it is clear that feed width 0.50 mm matches the system impedance of 50 

ohm which helps to reduce the resonance frequency. From the picture above the resonant 

frequency is 1 2.8 GHz. But here we observed an extra resonance frequency and higher return 

loss because of random feed position. We need to optimize the feed position. 

S. l Feed position optimization 

For the different feed positions we have simulated the S-pararneter and observing the results we 

will find the best feed position 

For Feed position 
O.72rnrn 

J 

�� ,.;' ----;-'';;--;-!;' ;-----:-'.:::-' -----;';;';;----:':;' ----,-'!,-;-- ,j \.2.t 1.25 , 28 , '11 1 . 28 Ui I 3 1 .31 1.32 
1 10'0 

Figure 45: Group of curves for finding the opti mum feed position 

epartment of Electrical and Electron ic Engineering, East West University 40 

For Feed 
position 
0.8 1 mm 

For Feed 
position 
0.89rnrn 



the position we changed the position of the feed 

: minimum return when we set the l ine at from the 

the edge. we 

of patch. 

re the minimum return loss of at resonant of 1 2 .8 1 This is because with 

ne at O.89mm, will minimum impedance mismatch between patch feed. 

ther n<OP'n"'rl measurements are at .72 mm feed return loss was - 1 3 .77dB 

eturn loss was - 1 5.2 1 

0 
- 1 0 
-20 

we choose optimum feed position, i .e .  O.89mm 

46:  Simulation result for optim um feed position 

8 1 1 

Minimum 
return 
Loss at 

for 

� -3 position 

-4 
-50 
-60 

0 5 1 0  1 5  20 

5.2 Secondary resonance in 1 x 2 array antenna 

the 

esonance. 

1 return 
-3 .067dB 

results we have 

resonance. 

-1 

1 -2 
-3 

o 

some excess resonance, we can see in 

the symmetric increases return loss 

S 1 1 

5 1 0  1 5  20 

introduces 

resonance 

Figure 47: Sim ulation result of 1 x2 a rray a n tenna using symmetric line feed 
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Secondary resonance in 2 x 2 array antenna 
imulation is for identical feed l ines a 2 x 2 array antelma; we 

found the fol lowing 

h reflection 
- 1  6dB 

- 1 0  

-1 5  
o 

8 1 1 

5 1 0  1 5  20 

48: simu l a tion resul t  o f l x2 a rray a ntenna using sym metric l ine feed 

�sonant frequency is at 1 5 .20 which is different the original value 

the 

ore secondary 
resonances 

)r high return loss and more secondary resonances we cannot symmetric l ine 

jesign. Then we used different configuration of feed l ine to remove these problems. 

feed width 
mulations are the we the method by the 

width using LineCalc 2 x 2 array. 

5 1 1 
0 

-1 
ro � 

gh return -2 

s of resonance 

6dB -3 

-4 
0 2 4 6 8 1 0  1 2  1 4  1 6  1 8  2 0  

Frequency 

Figu re 49: s imulat ion resu l t  o f !x2 a rray a n tenna using spl itt ing transm ission l ine feed 
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S1 1 

1 0  

5 

0 
::0 

� 
OJ 

-5 
co 

2 
-1 0 

-1 5 

..-

-� : 
1- -

I -, 

-20 

0 2 4 6 8 1 0  1 2  1 4  1 6  1 8  2 0  

Frequency 

Figure 50: Simulation result  of 2x2 array antenna using splitting transmission line feed 

l itling the transmission l ine is not a good solution because it is unable to eliminate extra 

mces and decrease return loss from the array antenna. 

our approach was to use quarter wave transformer to solve the problems mentioned above. 

5 .5  A/4 wave transformer in 1 x 2 array antenna 
:lve simulated the design using a Quarter-wave transformer in between the transmission 

o remove impedance mismatch. 

S 1 1 
0 

-5 ,-

co - 1 0 -l. " - --�- .. - . . Original resonant 
:£ 1 
OJ 

- 1 5 ---+ 

1 
frequency 

co 

2 -20 

VI/ Return 
:; 

-2 5 

-30 

0 5 1 0  1 5  2 0  

Im 1 Frequency 

Figu re 51 : Simulation result of 1 x2 array antenna using quarterwave 
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mant r .. ", r n u >n i s  1 which i s  approximately 

des use of quarter wave also reduces return loss which i s  

to our original frequency. 

dB. well  as i t  removes 

L resonant frequencies from the circuit. So  quarter wave i s  a healthy solution in 

further to 2 x 2 and 2 x 4 

5.6 Quarter wave transformer 2 x 2 and 2 x 4 array 
applied 

.lated the results. 

resonance §[ 
ith minimum OJ 

<1l 

return loss 
� 

�n l oss  i s  -40. 1 3  

OJ 
ro 
� 

nal resonance 
h minimu 
eturn loss 

transformer the Arrays of 2 x 2 and 2 x 4; we 
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Figure 52:  S imu l ation resu l t  o f 2x2 a r ray a nten n a  using q u a rterwave 

and resonant frequency is 1 2.48GHz and no extra resonance. 
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Figure 53: Simu lation resu l t  o f 2x4 a r ray a n tenna q u arterwave 
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IS dB resonant IS no extra resonance which is 

desirable. al l  are much suitable so we can easily as our solution 

5.7 Folded Quarter Wave Array design 1 x 2 x 2  

We have folded Quarter-wave in to the l ength we have simulated the 

design applying it in of 1 x 2 and 2 x 2 .  

81 1 
0 

-,t. / 
-4 

� -6 a, resonances 
(1l 
:2 -8 

-1 0 
resonance 

t: 

F requenc'! 

Figu re 54: Simula tion result  of h2 array a n tennas using folded 

we can see some secondary resonances and return loss though we used quarter 

wave. return is 1 1 .95dB. 
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resonanc 
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Frequency 

55: Simulation resu l t  of 2x2 a rray a n tennas using folded q u arterwave 
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e more distorted extra resonances are seen and return loss is also h igher. using only folded 

rter wave is not a 

5.8 Folded Quarter wave Array with Curved Turns 

)rder to match the impedance we need to the width identical along the l ine so we 

ved turns of Folded 

S1 1' 

Q -r--����--���----����� 
-2 

F requenc,/ 

resonance with 

high return loss 

56: S imu lat ion res u l t  of 1x2 a rray antenna using cu rved turns fol d ed q ua rterwave 

ill simulation i t  is  that resonant frequency which is 1 2 .79GHz i s  t o  our original 

)nance 1 2.8GHz and return loss of the original frequency is - 1 1 . 1 84dB. But there is an extra 

)nance and as it has a high return l oss so it is acceptable. 

1 

'iginal 

o 5 H i  1 5  2fl 

Extra resonance with 
return 

Figure 57: S i m u la tion res u l t  of 2x2 a rray a n tenna using cu rved turns folded q ua rterwave 
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e also resonant frequency ( 1 2 .86GHz) is matched with original frequency and the retum loss 

, .543dB) is also very low. We have an extra resonance but as it has high retum loss so it is 

�ptable. 

5.9 Folded Quarter wave Array with Mitered turns 

:emove the impedance mismatch in the tums of a Folded Quarter wave we need to keep the 

th same as the straight line. We used Mitered option to make the width identical. We then 

:.dated the S-parameter applying in 1 x 2 and 2 x 2 Array design 

iginal resonance 

2,-____ -, ______ .-______ -----. 

() 5 1{) 1 1'>  

Extra resonance with � .. +---:-:-high return loss 

.Figure 58: Simulation result  l x2 a rray a n tenna using mitered turns folded q uarterwave 

� the resonant frequency is a little different from original frequency which is 1 2. 6 1  GHz and 

:n loss is -8.860dB . 
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Figure 59: Simu lation result  of 2x2 array a n tenna using mitered turns fo lded q u a rterwave 
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;onant frequency is quite different from original 1 2.08GHz and return loss is - 1 2. 393dB. So 

ved turns fol ded quarter wave is a better solution than mitered turns fol ding. 

5. 1 0  Varied lengths of folded quarter wave sections 

,a rameter is sensitive to the length of the folded Quarter-wave, so we varied the length of the 

ded Quarter-wave to verify the range of tolerance. 

have Increased the length of the folded Quarter-wave by 5% and then by applying into a 2 x 

:ray we have the simulated the S-parameter in ADS. 
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Figure 60: Sim ulation result of folded qua rterwave a fter increasi n g  the length by 5% 

m the figure above we can see as we increase the length of the folded quarter wave by 5%, 

S-parameter result is  completely distorted and no original resonance is seen. 

have decreased the length of the folded Quarter-wave by 5% and then by applying into a 2 x 

ray we have the simulated the S-parameter in ADS. 
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Figure 61 : Sim u lation resu I t  o f  fo lded quarterwave after decreasing the length b y  5 %  

lon't find any original resonance around 1 2  GHz and S-parameter result is  also distorted like 

revious one. So tolerance range of the length is within 5% from the original length. 
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can conclude b y  that varying the length o f  the Folded 

lmeter. the ""'r,,, ,f-nl1t, of the IS 5%. 

5. 1 1  Comparison of Rounded and :Mitered turns 

d istorted S-

simulated the 2 x 4 array antenna. We 

mer-wave Mitered turns wave 

app lied both 

we 

turns folded 

the S parameter. 

: following S-parameter i s  for 2 x 4 array design where we have app l ied 

led Quarter-wave. 

iginal Resonant 
quency 

5.-r------�--------------------_. 
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-30���������������� 

o 5 1 0  1 5  20 

turns 

Figure 62: S imu lation result  of 2x4 array antenna using curved turns fo lded q uarterwave 

onant i s  1 return loss is -26.3 1  dB. 

following S-parameter is for 2 x 4 

ed Quarter-wave. 

design where we have applied the mitered turns 

2-r------------------------r-----� 

o 

frequencies 

63: S i mulation result  of 2x4 array antenna using mitered tu rns fo lded q ua rterwave 

the frequency is 1 a.250Hz and another one is 1 

·9.93dB So we can conclude by saying that every 

Return 

d wave i s  better turns folded quarter wave. 
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6 

. concern was to a compact 1 2. 8 GHz Microstrip patch array antenna with minimum return 

.. achieve minimum reflection we had to match impedance from transmitter to receiver. 

.oving impedance at first we tried different configuration of feed position. Our 

ervation was though optimum feed position played a vital role to mlnlmum but it 

Ie was not to reach our goal. So our next approach was two 

.smission lines in an array. But we saw it require more space if we use quarterwave. That's  why 

�nna. 

to think a solution to reduce area our focus was to design a compact 

n as solution we moved to folded than using 

It helped us eliminate extra spaces but it affected simul ation badly. Sharp 

es of the folded quarterwave again introduced impedance mismatch as well as extra resonances 

causes distorted simulation we curved and mitered turns to fold the 

rterwave transformer to reduce sharp in our We observed that curved turns folded 

ierwave transformers produced more accurate result than mitered tum folding. 

methodology we a compact 1 2. 8 GHz microstrip patch array antenna with 

mum return loss curved turns folded quarterwave between two transmission 

Ilations, analysis and simulation established ADS (Advanced Design 

�m, by Agilent Tools). Thus, it can be concluded our proposal holds. 
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7 

on our l earning we have identified the fol lowing as possible future work. 

• Folding the quarter wave changes the resonant frequency some cases. needs to be 

as to root cause the We used and Mitered turns to the 

problem there are other which must l ooked into . 

• We l imited the our arrays .  To abl e  to or transmit amount of 

with greater number of need to be investigated. 

• The quarter wave transformer can be designed as ring c ircle so that width remains the 

same along l ine. circle is a geometric fi gure. benefit of 

IS width identi cal along the l ine. This is a potential feed structure for 

the array antennas in an array. 

• with dielectric constants and different thickness should be 

to reduce the lenbrth of the Quarter-wave. can simplify and the 

""""'o:.u more compact. 

• In our we area array antenna. 

we can then """"'o:.u a flexible alTay. 
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APP ENDIX 

Proced u re of S-pa rameter simulation 

Iva need Design System (ADS) is an electronic design automation software system produced 

Agilent EEsof EDA; we have used this software to calculate the S-parameter. The procedure 

the Microstrip Patch antenna design in layout using the momentum menu is described below. 

First we opened the ADS software, From File menu we selected New project, we named 

EEE498_finalyroj ect. 

In the schematic window, from the layout menu we selected Generate/update layout. 
In the layout window, from the Option menu we selected Preference, and then we 

.ected the UNIT in mill imeter (mm) from Layout unit tab. 

Then we pul led down the option menu, in the Grid spacing we selected <. 05- 1 - 1 00>. 

We pul led down the Insert menu, then selected Rectangle, putting the cursor in the black 

ndow we designed the patch which was of dimensions of 4.0 1 mm and 3 . 55  mm. 

Then we designed the feed l ine width 0.47 mm. we placed the feed l ine on the left side of 

: rectangle plane. The feed line was placed 0.89mm away from the top of the patch. 

We selected the rectangular patch and then by pressing the ctrl button we selected the 

d line. We pulled down the Edit menu, and then we merged it to Union. 

From the Momentum Menu we clicked on substrate then we selected Create/modify. In 

)strate layers tab we renamed Air to Top and Aluminum to Dielectric from Substrate Layer 

me. 

Then we selected dielectric thickness to 20mil and then we set the dielectric constant Er = 

(real). We kept the Loss Tangent as default. 

We then selected Layer Mapping tab and then clicked on dotted line ( . . . . . ),  then we 

:ked on Strip. Then apply and Ok. 

From the Insert Menu we selected Port and attached it to feed line input. 

Then we saved the file by the name "file 1 " 

Then we pulled down the Momentum menu, clicked on Mesh and then we selected 

compute. We set it to 20 GHz. Then we clicked Ok. 
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After the mesh analysis is finished we again pulled down the momentum menu then 

eked on simulation and selected S-parameter. 
We set the start frequency I GHz and stop frequency 20 GHz for 25 sample points. Then 

• clicked on Apply and then we simulated the S-parameter. 

We pulled down the momentum menu again and clicked on Component then we selected 

?ate/update. Then Ok, ok, ok and yes to get out of the window. 

Then from the main window we pulled down the insert menu and then c licked on New 

lematic. From Insert Menu we clicked on Component and then we selected component library. 
en we opened the fi led from the l ist by the name it was saved. 

Then we placed the component in schematic window. We selected Simulation S 

·ameter. To terminate the port we placed a resistance on the port and grounded it. Then we 

ected S -parameter simulation and dragged it to schematic window. Double click on the s­

'ameter, we set the start frequency at 1 GHz and stop frequency at 20 GHz. We took 200 

nple points. 

Then we simulated the S parameter S ( 1 , I ) . In our design we did reduce the size of the 

gth of the array antenna. In the future we can reduce it more according to the need in the 

lice. If the device is large enough then we can design a flexible array. If the device requires a 

all array then we have to reduce the length of antenna size 
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l Our 

f the IS 

the 

below. 

64: Quarter-wave in  ADS 

l .  As our """ TP 11'1 was of 500hm HJvUUllvv and the width the was 0.5 mm so we 

L 

arbitrary selected 1 00 ohm transmission line. to get 1 00 ohm line we used LinCalc 

option to the width of for 1 00 ohm 

In the window of menu option we selected LineCalc 

then clicked on start 

-'-'U.''-'''''''I.U,,", window we 

20mi}, we 1 00 

Width the Transmission line which was 

of Er of Substrate H 

we 

0.067 m m  

From the Equation we calculated which is the characteristic impedance 

Quarter wave transformer. Here impedance or Feed impedance 50 

So the 

impedance which is Transmission 

we to be 70.7 ohm 

We repeated procedure (3) where we 

the Quarter wave and measured width = 0.067 mm and length 

With we Quarterwave in 

example i s  above) . 

1 00 

synthesized the width 

3 .0 1  mm 

layout window (an 
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